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What is CyberBoard?
The CyberBoard board gaming system makes playing board games by mail and electronic mail a
more enjoyable experience. The system allows you to easily graphically design the various parts of a
board game on your computer. The players can make their moves and exchange recorded versions of
the moves with their opponents. The opponent can then play back the moves. Although many types
of games may be created using CyberBoard, games that use counters or chits such as war games
work particularly well.

CyberBoard is not an artificial opponent. It provides no artificial intelligence capability.

The design goal for CyberBoard was to duplicate the experience of actual paper counter style
gaming--at least to the extent that this is reasonable. In its current form the system does a pretty good
job of this.1

What are its Features?
CyberBoard attempts to emulate real life board game components in an electronic format for
personal computers. Three main elements make up a CyberBoard game conversion:  gamebox files
hold the boards, pieces, markers, counter trays {{DLL-to be precise, the gamebox file has no
knowledge of counter trays. The scenario file is where they come into existence.)), etc.; scenario
files contain the starting situation of a particular game; and game files hold the current state of a
game as well as its entire history of play.

CyberBoard actually contains two program modules. A game designer program (CBDesign) is used
to actually design the components of a game, and a game player program (CBPlay) is used to create
scenarios and actually play the PBEM game.

*DPH 'HVLJQHU 3URJUDP )HDWXUHV�

• Graphical bitmap editor used for creating and manipulating tile images for counters, markers,
and terrain features.

• Free form graphics editor used for drawing lines, rectangles, ellipses, and polygons on the
board or on the tile images.

• Playing boards automatically created in three sizes: full scale, half scale and small scale.

• Board editing on three drawing layers: a grid layer sandwiched between two free form
drawing layers.

• Two-sided playing pieces optional.

• Graphical marker tiles available for marking various things during game play.

• Boards use hexagonal grids (two varieties), brick grids, and rectangular grids.

                                               
1 Larson, Dale. CyberBoard Web Page. 18 April 2000. http://www.execpc.com/~d-larson/cyberboard.html.
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• Grid lines hidden or drawn over the top of the map.

• Objects “snap” to grids or float freely over map.
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• Scenario designer used to layout the starting positions of a game; defines which game boards
and which playing pieces are to be used.

• Moves exchanged in small files that contain the recorded move to be e-mailed to your
opponent.

• Die roller used for combat resolution or other game functions.

• Auto stacking of pieces.

• Flipping two sided pieces.

• Rotation of playing pieces to indicating facings.

• Plotted moves used so your opponents can see the exact path taken when you moved your
pieces.

• Text messages sent any time while you're recording your moves.

• Entire history of a game maintained for posterity.

What Operating Systems Does CyberBoard Run On?
Windows 95, Windows 98, Windows NT Version 4.0 and Windows 2000

What is this Manual For?
This manual will describe the features of CyberBoard’s player program module, CBPlay.  All menu
commands and features will be described, and a how-to short tutorial will give an example of a game
in progress using CBPlay.  This manual assumes that the reader has a working knowledge of the
Windows operating systems listed above, including file management, mouse usage, and general
navigation.

CBPlay Overview
The player program is used to setup game scenario files and to play games.  A game scenario (file
extension GSN) contains the various pieces and playing boards that will be involved in a specific
game.  These pieces and playing boards are actually created using the CBDesign program module,
and are contained in a gamebox file (file extension GBX), which contains pieces and boards that
apply to different game situations.  The person designing the scenario must use CBDesign to create
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the master game components, which are then chosen to be included in the game scenario file.
CBDesign features are covered in a separate user’s guide.

Game files (file extension GAM) store the current state of a game and also store the entire history of
play.  You can reexamine a set of moves at any time by using the history playback feature.

Finally, when game moves are exchanged it is done using a game move file (file extension GMV).
These files contain a sequential record of all actions performed in since the last game file was saved.

Scenarios
A game scenario (file extension GSN) contains the various pieces and playing boards that will be
involved in a game.  It also defines a number of playing piece containers, called “Trays.”

&UHDWLQJ D 1HZ 6FHQDULR )LOH

1. Select the File menu and choose New.  Select the New Scenario item and click the OK
button.

2. You are now prompted to choose a gamebox file for the scenario.  Select the gamebox
file you'll be using and click the Open button.

3. You'll now see the Scenario Project window.  This window displays and controls most of
the information contained in a Scenario file.
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4. Select the Game Scenario list item and click the Properties button below the list box.  Fill
in the information about the scenario in the Scenario Properties dialog and click the OK
button.

5. Select the Playing Boards list item and click the Select button below the list box.  Select
the playing boards that are used in this scenario in the Select Boards dialog.  The dialog
contains a check box for each playing board in the gamebox file so more than one can be
selected. Click the OK button when you have selected all playing boards.

6. Select the Playing Piece Trays list item. Using this item you may create as many trays as
you like to hold the scenario’s playing pieces. All pieces entering a game must be first
placed in a tray. Press the Create button to create a new tray. Name the tray using the
Create Tray dialog and click the OK button.

7. The newly created tray and all selected playing boards are now visible under the Scenario
Project list box headings of Playing Piece Trays and Playing Boards.

8. Selected the newly created tray name and click the Edit button. Use the Setup Pieces
dialog box to move pieces from the gamebox file’s piece group(s) into the tray. The
dialog box also allows you to add units to other existing trays.
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9. Finally, select the File menu and choose Save to save the new scenario with a file name
of your choosing.  Click on the Save button when finished.
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1. Select the File menu and select Open.  In the File Open dialog use the file type list box
(located on the bottom middle part of the dialog) and select the Scenario Files file type.

2. Select the desired Scenario file and click the Open button. You will now see the Scenario
Project window.

3. You may make any desired additions or changes to the scenario file.  Make sure you
save your updated file.
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Games
Once a scenario is set up you can start a game. The state of a game is stored in a different file than
the Scenario file. In fact, once a game is started the scenario file is no longer required. Game files
(file extension GAM) store the current state of a game and also its entire history of play. You can re-
examine a set of moves at any time by using the game history feature.

&UHDWLQJ D 1HZ *DPH

1. Select the File menu and choose New.  Select the New Game item and click the  OK
button.

2. You are now asked to select an Initial Scenario file to use as the game's starting point.
Select the Scenario you wish to base the game on and click the Open button. Note that all
games must start from a Scenario file.

3. You'll now see the Game Project window.  This window controls most of the information
contained in a Game file.

4. Save your new game by selecting the File menu and choosing Save.  The Save As dialog
box will open, and you can name your game file.  Click on OK when finished.
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1. If you don’t already have your game file open, select the File menu and chose Open.
Select the desired game file and click the Open button.

2. If you have your gamebox and game files in different file folders (or even on another
disk), you may see the following warning box.  Click on the OK button and browse to
your gamebox file.

3. The Game Project window will be displayed when the game file opens.

4. Open the Playing Board by selecting the name of the board, and clicking on the View
button.
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5. The following example uses the game of Drive on Metz, from Chapter Four of James F.
Dunnigan’s book, The Complete Wargames Handbook.  As the rules of the game being
played will dictate exactly how you must proceed when playing the game in CyberBoard,
this example will only focus on a representative game of Drive on Metz.2

Note that you will have to keep track of movement costs and all other game rules
yourself.

NOTE:

If you would like to follow along with this example, you can download your own copy of
the Drive of Metz gamebox and scenario files from the Yankee Air Pirates CyberBoard
PBeM Support Page (http://members.home.com/yankeeap/ PBEM.HTM).  The Drive on
Metz files are listed, along with other fan-created gameboxes and scenarios for dozens of
wargames.  Just follow the instructions to download the desired file(s).  Note that the
gamebox and scenario files are compressed, and you’ll need to have a file decompression
utility, such as WinZip or PKUNZIP in order to use the files.3

6. Drive on Metz has the American units moving onto the board at the beginning of the
game, followed by a combat phase.  Move units on the board by selecting the View menu
and choosing Tray Palette A.  Each unit is dragged over to the west edge of the map with
the mouse, and the hex the unit is placed in counts as the first hex of movement.

                                               
2 Dunnigan, James F.  The Complete Wargames Handbook. 1997. http://www.hyw.com/Books/WargamesHandbook/Contents.htm
3 WinZip is a registered trademark of WinZip Computing, Inc.  PKUNZIP is a registered trademark of PKWARE, Inc.
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7. Once a unit is placed on the map, select the Actions menu and choose Begin a Plotted
Move.  The mouse pointer will change from an arrow to a crosshair.  Click within each
hex you wish to have the unit move through.  A line will be traced through the path of
hexes selected.

8. When you have finished moving the unit, select the Action menu and choose Accept
Plotted Move.  The unit will move to the last hex selected for its move.
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9. Continue in the same manner for each of the other unit you wish to move.  Note that a
shortcut Action menu can be selected by right-clicking the mouse when a unit is selected.

10. When all US units have been moved, play proceeds to the Combat Phase.  For this
example, there will be an attack by the US 7A/CCA in hex 0406 and 5/10 in hex 0407
against the German 462/1010 in hex 0507.  Each attacking unit’s combat strength is
added together (12 points), and this is compared to the defending unit’s combat strength
(1 point).  From this, a differential is obtained (12-1=11; differential +11).  This is then
compared to the Combat Results Table (CRT) in the Drive on Metz rules, which stops at
the +10+ column. Terrain effects reduce this by 3 columns, so the combat is to be
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resolved on the +4, +5 column on the CRT. {{DLL-perhaps the user should be told to
enter this sort of information via the send message feature (which you have done in
your picture).}}

11.  In order to resolve combat, click on the Roll Dice button at the bottom of the Send
Message dialog box.  The Roll Dice dialog box opens and you can select from a number
of die rolling options.  Drive on Metz uses a six-sided die to resolve combat.  Click the
Roll button to obtain a number between 1 and 6.

12.  The random number came out as a “4,” which indicates a combat result of “DR,” or
defender retreat one hex. {{DLL-Why did the message box split into two sections?
Confused newbies are dying to know. -- }}

13. Click on the Send & Close button to save the message and return to the game and
perform the retreat.  Select the 462/1010 unit, and drag it from hex 0507 to the adjacent
hex 0606.  The US 5/10 unit is selected to advance after the combat into hex 0507.
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14. After all other combats are resolved in the similar manner, it’s time to save the game
move file to send to your opponent.  Select the File menu and choose Send Recorded
Moves to File.

15. Enter the name of the game move file in the dialog box, and click the Save button.
NOTE:  It’s a good idea to develop a game move file naming convention, so that you and
your opponent can keep better track of your game in progress.  In this example, the move
file is named US01.gmv to represent the US first player turn.  When the German player
receives this file, he would then know what it represents.  When he completes his move,
he might save it with a name such as GE01.gmv.  Next turn, the US player saves his
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moves as US02.gmv, and the Germans save theirs as GE02.gmv.

This will allow the players to keep track of which set of moves are which, and also helps
rebuild a game if something would happen to the file, such as corrupted data or a hard
drive crash.

16. Once the game move file name is chosen and the Save button is clicked, you are
prompted to enter a move description.  The Title of the game move will be displayed
under the Game History, along with the date and time that it was saved. {{DLL-truth is
that the timestamp you see in a history list is the time the move file was ‘absorbed’ into
the game file’s history database. I do also save the timestamp for when it was created
but CB doesn’t display is at this time. This was implemented so long ago I have NO
idea why I made this decision.}}  The Description is a free-form text area to add any
comments, and will be shown whenever this move history entry is selected in the Game
History.  Click the OK button when finished.

17. Return to the Game Project window, and you’ll see the history entry.

18. Time to save the game file in progress and send the game move file to your opponent.
Select the File menu and choose Save.  Since you’ve already saved the game file, you
shouldn’t be prompted for a file name.
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19. Now you have a game file and a game move file.  You would normally only send the
game move file to your opponent, but for the first turn, it would be a good idea to send
both the game and game move files to ensure that both players are playing from the same
file.  Simply attach the game and/or game move file(s) to an e-mail message sent to your
opponent. {{DLL-If you send the game file after you save the move file it will already
contain the history entry for the move file. The German opponent will get an error
message when they perform the next steps in the tutorial. You probably should
recommend sending the GAM file before making any moves or have the German
player create a game from the scenario for the purposes of the tutorial. }}

Now over to the German player’s computer…

20. Great!  Your opponent’s turn just popped into your inbox, and you’ve already saved the
game move file to your computer.  Now let’s load the game move file and see what’s in
store for your player turn.  Select the File menu and choose Load Recorded Move File.

21. A dialog box opens, asking you to enter a move file name.  Select the game move file and
click the Open button.

22. The Game Project window now shows the US player’s game move as a history entry,
displaying the date and time, title, and description exactly as the US player entered them.
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23. Select the Playback menu and choose Next Move to begin the playback of the US
player’s turn.

24. The US units begin to appear on the west edge of the playing board, and you can see
them move as the US player ordered.  Continue to cycle through the US player’s turn by
selecting the Playback menu and choosing Next Move.  Note that you may also use the
keyboard shortcut of F3 for Next Move.
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25. Once you have finished playing back the entire US player’s turn, you need to accept this
history entry into your game file.  Select the Playback menu and choose Accept Move
File Playback.

26. Save your game file, and proceed with your own turn, as described in the preceding steps.
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Scenario Project Window Reference
When the scenario is loaded you will see the scenario project window.  The leftmost list box shows
the contents of the scenario file. The rightmost area in the view generally shows information about
the currently selected item in the project list box.

When an item is selected in the contents list, a set of buttons below the list box will be set to the
available operations for the selected item. For example, to view the playing board, select a playing
board list item under the Playing Boards heading and click the View button. A view is opened
showing the board.

The following item types are available in a scenario project’s contents list:

Game Scenario
This item controls information related to the Scenario file as a whole. It has the following button:

Properties - Displays the Scenario Properties dialog.

Playing Boards
This item is used to control the boards that are to be used in a game based on the scenario. It has the
following button:

Select - Displays the Select Boards dialog.

Playing Board Names
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These items are the playing boards used for play. They have the following buttons:
View - Displays a Playing Board window for this board.
Properties - Displays the Board Properties dialog for this playing board.
Remove - Deletes the board from the active list of playing boards.

Playing Piece Trays
Trays are containers that hold playing pieces. All plying pieces that are used in a game must first be
imported into a tray. This item has the following button:

Create - Displays the Create Tray dialog.

Playing Tray Names
These items are the trays that are currently defined in the scenario. When these items are selected, the
rightmost part of the scenario content window displays the current contents of the selected tray. The
following buttons are available:

Edit - Displays the Setup Pieces dialog.
Properties - Displays the Tray Properties dialog.
Delete - After giving you a chance to change your mind, deletes the highlighted tray and its
contents.
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Game Project Window Reference
When the game is loaded you will see the game content window.  The leftmost list box shows the
contents of the game file. The rightmost area in the view generally shows information about the
currently selected item in the content list box.

When an item is selected in the content list, a set of buttons below the list box will be set to the
available operations for the selected item. For example, to view the playing board, select the Playing
Board list box item and press the View button. A view is opened showing the playing board.

The following item types will be displayed in a game project’s content list:

Game
This item displays information related to the Game file as a whole. It has no associated buttons.

Playing Boards
This displays a list of all boards involved in the game. It has no associated buttons.
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Playing Board Names
These items are the playing boards used for play. They have the following buttons:

View - Displays a Playing Board window for this board.
Properties - Displays the Board Properties dialog for this playing board.

Game History
This is the heading for the history of the game. It has the following button:

Load - Selects a move file for loading and activation. After loading, playback mode is begun
and you may view the moves in the file.

<Move File Playback>
This item is available when you load a recorded move file into the game, but have not yet saved into
the game file. It has the following buttons:

Accept - Used to accept the recorded moves into the game file.
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Discard - Used to discard the entire recorded moved file.

<Current Recording>
This item is available if you have made any changes or moves in the game, but have not yet saved
them as a game move file. It has the following buttons:

Save - Used to save the recorded moves in a file. Send this file to your opponent.
Discard - Used to discard the entire recording.

[Date] [Time] - History Record Descriptions
As the game is played each set of move is stored in a game history database in chronological order.
This is done so you can go back a review the game at any point in its history. These items have the
following buttons:

Replay - Used to playback that history record.
Export - Used to store the record as a move file.
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<History Entry Playback>
This item is shown if you are viewing (playing back) one of the saved games in the history list. The
active history record is marked at left with the chevron character. It has the following button:

Done - Used to exit the history playback mode. Any move recording will be resumed at
where you left off.

Menu Command Reference

File Menu

New…

Opens dialog box for creating a new scenario file or game file.  Keyboard
shortcut – Ctrl+N

Open…

Opens dialog box to select and open an existing scenario or game file.
Keyboard shortcut – Ctrl+O

Close

Closes current scenario or game file.
Save

Saves current scenario or game file.  Keyboard shortcut – Ctrl+S
Save As…

Opens dialog box for saving scenario or game file.
Recent Files Opened

Displays up to four of the most recently opened scenario or game files.
Exit

Closes CBPlay program module.  Keyboard shortcut – Ctrl+F4

Edit Menu

Copy Board Image to Clipboard
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Creates a copy of the current playing board image (including all units and
markers displayed on board) to the Windows Clipboard.  Keyboard shortcut –
Ctrl+C

Save Board Image in File…

Opens a dialog box for saving the current playing board image (including all
units and markers displayed on board) as a file in Windows Bitmap (BMP)
format.

Delete Markers

Removes all selected markers from playing board.  Keyboard shortcut –
Delete

Select All Markers

Allows user to select all markers currently displayed on the board.
Select All Markers From

Allows user to select all markers {{DLL-“on the current board that were
created from a particular marker tray.”}} from the same marker tray
currently displayed on the board.  A submenu listing the available marker
trays pops up when selected.

Board Properties…

Opens Board Properties dialog box.

View Menu

Main Toolbar

Toggles main toolbar on and off.
Status Bar

Toggles status bar on and off.
Snap Grid

Toggles snap grid on and off.
Tray Palette A

Toggles tray palette A on and off.
Tray Palette B

Toggles tray palette B on and off.
Marker Palette

Toggles marker palette on and off.
Full Scale Board

Switches to full scale board visibility.
Half Scale Board

Switches to half scale board visibility.
Hide Pieces
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Toggles unit and marker visibility on and off.  Keyboard shortcut – F9
Indicators on Top

Toggles movement path display above or below unit counters.  Keyboard
shortcut – F10

Project Menu
(only visible with scenario file open)
Create Playing Piece Tray

Opens Create Tray dialog box.
Create Trays from Piece Groups

Opens Import Piece Groups dialog box. {{DLL-a useful scenario creation
shortcut for those people desire trays arranged the same way they group the
pieces in the gamebox. }}

Select Game Boards

Opens Select Boards dialog box.
Select Game Pieces

Opens Select Pieces dialog box.
Scenario Properties

Opens Scenario Properties dialog box.

Actions

Auto Stack

Stacks all selected units using the Auto Stack settings in the Board Properties
dialog box.  Keyboard shortcut – Ctrl+A

Move to Front

Moves the selected object to the front display layer.  Keyboard shortcut –
Ctrl+F

Move to Back

Moves the selected object to the back display layer.  Keyboard shortcut –
Ctrl+B

Turn Piece Over

Flips the selected unit to its back side, if it has one.  Keyboard shortcut –
Ctrl+I

Rotate Piece – Incremental

Opens the Rotate Piece dialog box.  Pieces may be rotated 5, 10, or 50
degrees, clockwise or counterclockwise.
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Rotate Piece – Absolute {{DLL-used for shorcuts  for facings that are more commonly
encountered in game play. }}

Opens a submenu displaying the following selections:
Reset Rotation – removes any rotation from the selected unit.
Square Faces – opens a submenu allowing the selected unit to rotate to the
following angles: 0, 90, 180, and 270 degrees.
Hex Faces (Flat Up) – opens a submenu allowing the selected unit to rotate
to the following angles: 60, 120, 240, and 300 degrees.
Hex Faces (Point Up) – opens a submenu allowing the selected unit to rotate
to the following angles: 30, 150, 210, and 330 degrees.
Diamond Faces– opens a submenu allowing the selected unit to rotate to the
following angles: 45, 135, 225, and 315 degrees.

Begin a Compound Move

(only visible with .GAM file open)
Begins recording a compound move.  Compound moves allow you to make
the playback of individual moves much faster by collecting all unit moves
into one replay action.  Keyboard shortcut – Ctrl+Enter

Accept a Compound Move

(only visible with .GAM file open)
Completes the compound move and accepts the move into the game history.
Keyboard shortcut – Enter

Discard a Compound Move

(only visible with .GAM file open)
Abandons the entire compound move, returning all selected units to their
locations prior to the compound move.  Keyboard shortcut - Esc

Begin a Plotted Move

(only visible with .GAM file open)
Begins recording a plotted move.  Plotted moves are replayed one step at a
time {{DLL-showing the path the selected pieces took to get to the final
location as a plotted line. }} (not one hex at a time, but one unit at a time).

Accept a Plotted Move

(only visible with .GAM file open)
Completes the plotted move and accepts the move into the game history.

Discard a Plotted Move

(only visible with .GAM file open)
Abandons the plotted move, returning the selected unit to its location prior to
the plotted move.

Roll Dice

(only visible with .GAM file open)
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Opens the Send Message dialog box, then opens the Roll Dice dialog box.
Keyboard shortcut – Ctrl+R

Enter Message

(only visible with .GAM file open)
Opens the Send Message dialog box. Keyboard shortcut – Ctrl+M

Playback Menu
(only visible with .GAM file open)
Start of Moves

Moves the game playback to the first move of the current history entry or
move file playback.  Keyboard shortcut – F2

Next Move

Moves the game playback to the next move of the current history entry or
move file playback.  Keyboard shortcut – F3

Previous Move

Moves the game playback to the previous move of the current history entry or
move file playback.  Keyboard shortcut – F4

End of Moves

Moves the game playback to the end of the current history entry or move file
playback.  Keyboard shortcut – F5

Single Step Compound Moves

Allows compound moves to be replayed as single step, just as plotted moves.
{{DLL-shows all the individual moves that made up the compound move.
This isn’t really like the plotted move that shows a line plot. In fact, if a
person where insane enough to try it, a compound move can contain plotted
moves. }}

Next History Entry

Moves the game playback to the next history entry or move file playback.
Close History Playback

Stops the history entry playback.
Accept Move File Playback…

Accepts the current move file playback into the game history.
Discard Move File Playback

Rejects the current move file playback.
Show Current Message

Displays the Send Message dialog box.

Window Menu
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Cascade

Displays all open windows stacked one on top of the other.
Tile Horizontally

Displays all open windows stretched horizontally across the screen.
Tile Vertically

Displays all open windows stretched vertically across the screen.
Arrange Icons

This menu selection is inactive.
Horizontal Split

Splits the currently active window into two windows, stretched horizontally
across the screen.

Vertical Split

Splits the currently active window into two windows, stretched vertically
across the screen.

Active Windows

Allows the user to switch to a different active window.

Help Menu

Index

Displays the CyberBoard Help feature.  Keyboard shortcut – F1
Using Help

Provides instruction on how to use the Windows Help feature.
About CyberBoard

Displays an information box for the CyberBoard program.

Toolbar Command Reference

 

Referring to the image above, reading from left to right, the following menu commands are
available from the toolbar:

New Game or Scenario
Open Game or Scenario
Save Active Game or Scenario
Send Recording to File
Load Recorded Move File
- (separator) -
Start of Moves (F2)
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Previous Move (F4)
Next Move (F3)
End of Moves (F5)
Open Next History (F6)
Close History Playback
- (separator) -
Toggle Board Scale
Hide Pieces
- (separator) -
Piece Tray A
Piece Tray B
Markers
- (separator) -
Begin Compound Move (Ctrl+Enter)
End Compound Move (Enter)
Discard Compound Move (Esc)
- (separator) -
Enter Message (Ctrl+M)
Roll Dice (Ctrl+R)
- (separator) -
Move Pieces to Front (Ctrl+F)
Move Pieces to Back (Ctrl+B)
Auto Stack (Ctrl+A)
Turn Piece Over (Ctrl+I)
- (separator) -
Toggle Snap Grid


